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SECTION 1 INTRODUCTION

The PC6000 program is very useful in the operation of the YSI Sondes, and is provided as an option
with every sonde.  This PC-based software can be used with any IBM-compatible computer.

PC6000 enables you to:

! Configure and deploy the sonde
! Capture data from the sonde
! Create a variety of reports and plots
! Print reports and plots
! Save reports and plots to disk
! Export data to other programs

The PC6000 program is completely menu-driven and easy to use. You can:

•  Use the arrow keys to move the cursor and highlight menu options.
•  Use the Enter key to select a highlighted menu option.
•  Use the Esc key to return to a previous screen.

When each menu option is highlighted, a short, descriptive help line is displayed at the bottom of
the screen.

In Section 2 of this manual, you will learn how to:

•  Install the software to your PC
•  Run the software and set up the Com ports, and the display and plot colors
•  Establish communication between your sonde and computer using PC6000

Section 3 of the manual provides the basics on how to:

•  Capture data from the sonde to your computer using PC6000
•  Upload data from your sonde to your computer
•  Report, plot, and analyze data files using PC 6000 software

Sections 4 through 9 provide complete details of the capability of  PC6000 as well as providing YSI
Customer Service contact information and a list of YSI sonde and software accessories.



SECTION 2 GETTING STARTED

2.1 INSTALLING PC6000 SOFTWARE

PC6000 software can be used with an IBM-compatible PC with at least 256KB of RAM and
DOS 3.0 or later.  If your system is not IBM-compatible, any terminal emulation program can be
used with your computer.  PC6000 software is an optional accessory that can be requested at no
charge with each Sonde.  The diskette is located in the back of this instruction manual.

You need a graphics adapter for operation of the plotting feature.  You need one RS-232 port (also
called a Com port or serial port) to communicate with the sonde and to capture data files.  This port
must be either Com1 or Com2.

For IBM-compatible computer systems with a hard disk drive:  Insert the PC 6000 disk into
your floppy disk drive.  At the C:\ prompt, type the letter of the drive in which the disk was
inserted followed by a colon, then press Enter.

Example: “A: Enter”

To install PC6000 software execute the following command from the DOS prompt:
“INSTALL  <destination>” where <destination> is the drive and directory in which you want
the PC6000 files to be installed.

Example: “INSTALL C:\PC6000”

If you have a non-standard video adapter and monitor (rare except on CAD work stations) you
will also need to:

1. Put your video adapter into a compatible (standard) video mode.  Typically the manufacturer of
the video adapter provides a program or utility to set the video mode.

 
2. Type PC6000-V to run the program.  This tells PC6000 to send video output through the

computer BIOS (built-in firmware), rather than directly to video memory.  This procedure
slows down the video output somewhat, but guarantees compatibility.
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2.2 RUNNING SOFTWARE

To start the software, make your current drive C:\PC6000 (or another directory where you have
installed PC6000).   Then type “PC6000” and press Enter.  The PC6000 software will load and
the menu bar will appear at the top of the computer screen.

Use the arrow keys to move the cursor and to highlight different menu options.  Press Enter to
select a highlighted option.  Press Esc to cancel an entry.

 PC6000 Main Menu Bar

Sonde File Setup Real-Time Exit PC6000

2.3 SOFTWARE SETUP

To begin setting up your computer to communicate with a sonde, highlight Setup and then press
Enter.   Check the default setup values by referring to the following instructions and/or the
PC6000 Setup Screen below.

Select the Comm option to enter the number of the Com port (1 or 2) to which your sonde is
connected.  Press Enter to confirm a new entry.  If the default setting is correct, it does not need
to be changed.

---DISPLAY -FORMATS---------COMPUTER-CONNECTIONS-------------------
Date format: MDY Comm port: 1
Date separator: / Baud rate 9600
Time separator:  : Printer Port 1
Radix mark:   .          Printer type HP LaserJet laser

-------MORE-SETUP-------------COMPUTER-DISPLAY---------------------
Data capture setup... Menu colors: User-defined menu colors
Advanced Setup... Plot colors: User-defined plot colors

Graphics mode: Automatic selection hi-res
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Select the Baud option to check the baud rate.  The baud rate should be 9600. If it is not,
highlight it and press Enter.  A list of possible baud rates will appear.  Select 9600 from the list
and press Enter.

Select the Printer option to specify the parallel port (LPT1, LPT2 or LPT3) to which your
printer is connected.  If no printer is connected, select LPT1.  Press Enter after making your
selection.

Select Printer type to select the type of printer connected to your computer system.  From the
list, choose the selection that best describes your printer.  If your printer is not on the list, refer to
your printer's instruction manual to determine what type of printer your printer emulates.  Press
Enter after making your selection.

Select the Menu colors option to choose a color scheme for the PC6000 menus.  As you move
the cursor between color schemes, the screen changes to display your selection.  Press Enter to
confirm a selection.

Select the Plot colors option to choose a color scheme for the PC6000 plots.  As you move the
cursor between color schemes, the screen changes to display your selection.  Press Enter to
confirm a selection.

Other setup functions are described in Section 4.2, Setup Menu, but are usually are not
necessary for a quick start into the sondes operations.  Press Esc to exit the Setup Menu.  The
cursor will return to the PC6000 Menu bar.
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The PC6000 menu flow chart will help you visualize the relationship between the most often used
options in this PC-based software.  To better understand the relationship between Sonde software
and PC6000 PC software, the sonde software menu items are listed in the shaded areas.  Refer to
this chart as you learn more about the specific functions of these menu items in the following
descriptions.

PC6000 Menu Flow Chart for Sondes (Some choices in the sonde menu are not available with all sondes)

2.4 COMMUNICATING WITH YOUR SONDE

There are two sets of software at work within the YSI sonde.  PC6000 is resident in your PC, while
the other software is resident in the sonde itself.  When you select Sonde from the PC6000 Main
menu the PC based software begins direct communication with the sonde-based software via
standard VT100 terminal emulation.

Using the arrow keys, highlight and select Sonde from the Main menu bar.  Press Enter as
instructed, type “menu” after the # sign and the Main sonde menu will appear.

To use PC6000 to establish communication between your computer and sonde:

Sonde File Setup Real-Time Exit

1. Run               

4. Status           

3. File                

2. Calibrate       

Display Format

Computer Connection

Computer Display

More Setup

View

SystemModify

Filename

Data Capture

Advanced Setup

Parser

Site Name

Instrument ID

Filename

Autoconfigure

X-axis Time

Parameter/Plo
t

Beep Notify

Advanced Setup

Global Switch

Data Files

User-defined

Export

Readings 
Displayed

Return to DOS

PC6000 MENU FLOW 

6. Report          

5. System         

7. Sensor          

8. Advanced     
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1. Connect one end of your YSI cable to the sonde and the other to the computer ‘s Com port
that was selected above.

2. Make certain that your sonde is powered either with batteries or a power supply.

3. Using the arrow keys, highlight the Sonde selection in the top menu bar of PC6000 and press
Enter.

A display similar to that shown below will appear, followed by a # sign.   As instructed, type
“menu” after the # sign and the Main sonde menu will appear.

PC6000 Main Menu Bar
Sonde File Setup Real-Time PC6000

# menu

Sonde Main Menu

After establishing sonde communication proceed to Section 2 of the Sonde’s Operations manual
supplied with your sonde to learn about the basics of Sonde setup.   Pay particular attention to
leaning low to set up Discrete Sampling and Unattended Sampling studies from the Run menu.
Then proceed to the next section of this manual to learn how to capture data from the sonde to
the computer in real time, to upload data from sondes containing memory, and to analyze the
captured or uploaded data.

------------------Main-----------------
1-Run               5-System
2-Calibrate         6-Report
3-File              7-Sensor
4-Status            8-Advanced

Select option (0 for previous menu):



SECTION 3 USING PC6000 TO CAPTURE, RETRIEVE AND
ANALYZE DATA

CAPTURE – ALL SONDES

Once you have learned how to carry out Discrete Sampling studies using the sonde software
(Section 2 of your Sonde Operations Manual), you can capture that information into a data file
on your computer hard drive.  This function is particularly useful when using sondes with no
internal memory (600R, 600XL, and 6820).  Note, however, that this capture function can take
place only after the PC6000 software has been properly configured to match your parameter
selection as described in the following paragraphs.

PC6000 uses the date and time from your PC’s internal clock to stamp each incoming data point.
It is important, therefore, to make sure that the date and time are set up correctly inside your
computer.  Consult your computer instruction manual if you are unsure how to set the internal
clock.

To set up for data capture return to the PC6000 menu bar by pressing F10.

Sonde File Setup Real-Time PC6000

# menu

Highlight Setup from the top-line menu and press Enter.

Select Data Capture Setup from the Setup menu and press Enter.  The Data Capture Setup
menu will be displayed.

Parser: 6000
Site name: Clear Lake X-axis time per screen: 1
Instr ID:  96E12345 Parameters per plot:    2
Filename:  CLRLAKE3 Auto-configure Beep notification:    Both

ColumnParameter & Units Minimum Maximum

Use the arrow keys to highlight the Filename: then type in a name that you will use to store the
data on the computer hard drive or diskette.  Remember that while you can type up to 15
characters in the name, MS-DOS will only recognize the first 8 for file designation.

Now highlight Auto-configure and press Enter.  This makes sure that the Data Capture setup in
PC6000 software has the same parameters as selected in the Report setup of the Sonde software.
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The parameters listed in the lower part of the display (not shown) are likely to change during the
Auto-configure execution.

IMPORTANT:  Without the execution of the Auto-Configure command, the PC6000 software
may display error messages that refer to “differing parameters” that prohibit you from
proceeding.

Leave all of the other selections with their default settings intact and then press Esc twice to
return to the menu bar of PC6000.

To capture data, use the arrow keys to select Sonde from the main menu and press Enter.  At the
# sign type “menu”.  This command returns you to the Main Sonde menu.  Next select 1-Run
from the Main menu, and 1-Start sampling from the Setup Menu (600R, 600XL or 6820) or the
Discrete Sample menu (600XLM, 6600 or 6920).  Lines of data will be displayed to the screen
and updated at the interval specified.

Now press the F3 key and a message appears on the screen asking for the type of data file you
wish to create.  Select PC6000 and press Enter.  A message now appears on the screen asking,
“OK to create new data file?”  Press Enter to indicate ‘yes’ and data capture to your
designated file will begin.

As noted above, a change in the format of the displayed data in that both date and time will now
be displayed.  In this mode, data appearing on the screen will be saved to your computer memory
until you press either Esc or F3.  When you press either of these keys, data capture halts and
returns the display to the original data scrolling.  A second press of Esc will stop the sampling
and return the display to the Run menu.

You may view and/or analyze the data by pressing F10, and then following the instructions in the
Section 3, Analyzing Data.

RETRIEVE – 600XLM, 6600 AND 6920 SONDES

PC6000 Software can also be used as the interface to transfer (upload) data logged to sonde
memory from the sonde to the computer hard drive.  This function only applies to sondes with
internal memory (6920, 6600 and 600XLM).

To carry out this operation, consult Section 2 of your Sonde’s Operations Manual on the logging
of data to sonde memory using the Discrete Sample and Unattended Sample features of the sonde
software.   Make certain that you have logged at least one file (or study) to the sonde memory.
After logging is complete and the studies terminated, attach the sonde to the computer via the
YSI cable as described above.

You may now retrieve data files using the following procedure.  Remember these are not files in
the PC6000 directory, but are in the sonde file directory.

Run PC6000 software on your PC and select Sonde from the PC6000 menu bar using the arrow
keys. At the # sign, type “menu” to enter the Sonde Main menu.  Next select 3-File.
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Select number 1-Directory to view all files currently stored in the sondes flash disk memory, the
screen below shows 5 files.  File 4-CLRLAKE2 is a 2-week study from August that can be
uploaded to PC6000 for viewing or plotting.  The other 4 files are related to different studies.
You do not need to upload all files in the directory.

Press Esc to return to the previous menu, File.

Select number 2-Upload to view file lists in memory, and uploads the data to PC-based software.
With YSI PC6000 software you can produce reports, plots, data manipulation, statistics, and
more.

Prior to upload, a “Time window” display appears that will allow you to select portions of the
logged data to upload.  You may select 1-Proceed to upload all logged data from the dates and
times displayed.

Select 1-Proceed.  Choose the appropriate file transfer protocol (in this example, PC6000) and a
status box will appear in the lower right quadrant of the screen.  Verification of a successful
transfer is indicated when all of the requested data are transferred.

------------------File-----------------
1-Directory 4-View file
2-Upload 5-Quick view file
3-Quick Upload 6-Delete all files

Select option (0 for previous menu): 1

  File     Samples  First sample       Last sample        Interval  Site
1-BRIDGE1       20  07/10/96 09:42:52  07/10/96 09:44:12  Discrete  Kenton Rd.
2-BRIDGE2       20  07/10/96 10:15:20  07/10/96 10:16:40  Discrete  Lakeview Dr.
3-UPLAKE       672  07/10/96 12:00:00  07/14/96 12:00:00  00:15:00  Lake Site A
4-CLRLAKE2    1672  08/14/96 11:00:00  08/28/96 11:00:00  00:10:00  Clear Lake
5-DWNLAKE2      21  08/31/96 12:42:31  08/31/96 12:43:54  Discrete  Lake Site B2

Select option (0 for previous menu):

--------------Time window--------------
1-Proceed
2-Start date=08/14/96
3-Start time=18:00:00
4-Stop  date=08/28/96
5-Stop  time=11:00:00

Select option (0 for previous menu):
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In the File menu, when you select 3-Quick Upload, the same operation as 2-Upload is
performed, except only the most recent flash disk file is uploaded in its entirety.  You still must
choose the transfer format.

Select 4-View File to examine the data in any file currently stored in the sondes flash disk
memory.  You will first view the same screen as viewed in the Directory menu.  From this menu
choose the file of interest, then, using the Time window menu, choose the dates and/or times of
interest.  If you choose dates or times that are not within the designated start and stop times, no
data will be displayed.

You also may choose the entire file.  You can use the Space Bar to stop and restart the scrolling
at any time. Use the Esc key to stop the view.

Select number 5-Quick view file to view the last page of data from the last data file in flash disk
memory.  This feature is particularly useful to quickly review any recently acquired data so that
system performance can be assessed.

Select number 6-Delete all files to IRREVERSIBLY removes all files from the sonde flash disk
memory.  It is critical not to use this option until all relevant data from sonde memory is
transferred to your computer via one of the upload options.  There is a verification screen that
appears, so that pressing the number 6-key does not immediately delete all files.

Now proceed to the next section to get the basics relevant to analyzing your captured or uploaded
data.

ANALYZE

This section provides only basic information on obtaining reports, plots, and analysis of your
uploaded or captured data files.   Detailed information on the many powerful functions
associated with these aspects of PC6000 software are found in Section 4, PC6000 Menus of this
manual.

To begin your data analysis, select File from the PC6000 menu bar.

A box will appear on the screen asking you to enter a filename. You may type a filename or press
Enter for a directory listing all PC6000 format files on your hard drive.  Use the arrow keys to

---------------File type---------------
1-PC6000
2-Comma & ' ' Delimited
3-ASCII Text

Select option (0 for previous menu):
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highlight the desired file and then press Enter  to access the selected file.  If only one file resides
in the directory, it will automatically load into PC6000.

Filename:
CLRLAKE2.DAT

MODIFY VIEW SYSTEM

Parameters...
Control Info...
Scaling Info...

Header
Report
Plot
Statistics

Print Report
Print Plot
Definitions
Export

Any changes you make from this menu will affect only the file listed, in this case
CLRLAKE2.DAT.  To change default values for all files, see Section 4.1, File Menu.

To view general information on the screen including filename, site description, a list of active
sensors, logging information, and more use the arrow keys to highlight Header and press Enter.
Press Esc to return to the File menu.

Using the arrow keys highlight Report, press Enter and the information will scroll by.  You can
view a time-stamped report of the entire set of data collected in the study. Press Pause/Break to
stop the report and press Enter to resume.  Press Esc to return to the File menu.

Select Plot to view a graphical expression of the data from the study. All Reports and Plots can
be customized to your preference.

Press Esc until the menu of the PC6000 program appears.  You have now completed Basic
Operation of the sonde, which included basic calibration procedures, basic sampling and
deployment procedures, data capture, and data retrieval and viewing using PC6000 software.



SECTION 4 PC6000 MENUS

4.1 FILE MENU

The File menu option of PC6000 software allows you to specify and customize reports and plots
based on data that has been captured from the sonde.  Select File from the PC6000 menu bar, and
press Enter.

Sonde File Setup Real-Time Exit PC6000

The following prompt appears on the monitor screen.

Filename:  *.dat

At this prompt, press Enter.  A list of all data files in the current directory will be displayed.
Highlight the file you wish to retrieve from the list.  If only one data file exists, that file will be
loaded automatically.

SAMPLE.DAT 38046 2/06/92 11:11 am
CLRLAKE.DAT 21035 10/30/93 6:00 am
RIVER2.DAT 1926 7/23/96 10:22 pm

NOTE:  To retrieve files stored on another drive or directory, at the filename: prompt, type the
source drive and directory, then press Enter.  For example, when you type A:\PC6000\ at the
prompt, you will view a list of all files located in the directory named PC6000 and stored on a disk
in the A: drive.

When you choose a file, the following screen will appear.  Highlight the option you prefer, then
press Enter.  Use the Tab or Arrow keys to move through the options.  There are 10 options, the
first being “Parameters”.  MODIFY, VIEW and SYSTEM are column headers only.  The figure
below shows “Parameters” is highlighted as an example.
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Filename:  SAMPLE.DAT

MODIFY VIEW SYSTEM

Parameters... Header Print Report
Control Info... Report Print Plot
Scaling Info... Plot Definitions...

Statistics

The following descriptions are the various options under the File menu, beginning with MODIFY,
then VIEW, and finally SYSTEM.

4.1.1 MODIFY

Any modifications performed with these functions will allow you to customize data and format
reports and plots for a selected file only.  See Setup later in this section to change default values
permanently. Select Parameters from the Modify menu.

The Parameters menu helps you define the way you want your reports and plots to appear.  When
you highlight any parameter on this display and press Enter, the submenu appears. Each of the
submenu functions is described below.  You may select one parameter for the X-axis, and up to
twelve parameters for the Y-axis.

Select Add parameter here to add a parameter to a report or plot.  A list of all available parameters
that can be added will be displayed.  Choose those parameters that you want to be included in
reports and plots.

Select Delete this parameter to delete the highlighted parameter from reports and plots.

Select Move parameter up or Move parameter down to shift the highlighted parameter up or
down one position.  By using these options all parameters within a report and plot can be displayed
in the order you prefer.

 X-axis parameter
 ------------------------
 Date + Time

 Y-axis parameter
 ------------------------
 Temperature C
 Specific Cond mS/cm
 DO mg/L
 pH
 ORP mV

 Add parameter here
 Delete this parameter
 Move parameter up
 Move parameter down
 Detail this parameter
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Select Detail this parameter to view the detailed information of a highlighted parameter.  PC6000
has many built-in formulae.  Each formula accepts certain inputs and produces a single output.  An
example of this is the formula for specific conductance, which is calculated from temperature and
conductivity.  Most formula inputs must be in the input data file from the sonde, but some can be
entered as constants.  For example, the total dissolved solids (TDS) constant can be manually
entered.

Parameter: TDS (g/L)

Formula: Temp(C)  Cond(mS/cm)  TDScoef

Inputs: Temperature (C) from 6030 probe, channel 0
Conductivity (mS/cm) from 6030 probe, channel 3
TDS coeff source not selected

Compensate:

Parameter identifies the parameter you just chose.

Select Formula to view and change the formula used by PC6000 to calculate the selected
parameter.  This option will allow you to change formulae and input sources only in circumstances
where multiple formulae or input sources exist.  If formula options for the highlighted parameter
exist, they will be displayed when pressing Enter while the formula is highlighted.

The Inputs option is reserved for future software enhancements.

Select Compensate to compensate a data file for long term sensor drift.  This compensation
procedure is also commonly called Post-Calibration.

Compensation Example: Dissolved oxygen data can be collected periodically
throughout a long-term deployment using a separate, freshly calibrated DO meter.
This independent data can then be used to compensate the sondes data for any
sensor drift that may occur over time.

NOTE: The setup menu options for date format, date separator, time separator, and radix separator,
all apply here.  The date, time and value are separated from each other by spaces.  Lines that do not
match the above format are ignored.

To create a compensation file, use a word processing program or follow the procedure below.  The
file must be simple ASCII.  In WordPerfect you use the DOS Text Out feature.  In Word, save as
file type Text Only (*.TXT).  From DOS, proceed as follows:

1. Issue the DOS command "COPY CON DO.CMP".  The DO designation reminds you
      that you are compensating DO % data in this exercise.

2. Type the compensation data into your file, placing each independently acquired reading
on a separate line.  Make sure each line is correct before you press Enter for that line.



PC6000 Menus Section 4

YSI Incorporated PC6000 Software Operations Manual 15

Example: 12/31/92 23:59:59 100
1/15/93 16:02:00 98
2/15/93 18:00:00 94

In this example, an independent DO reading taken at 4:02 PM on 1/15/93 showed a value
of 98 % air-saturation.

3. After the last line has been typed and entered, hold down Ctrl and press Z, then press
Enter.

4.  The message “1 File(s) copied” should appear.

If only one data point is entered into the compensation file, all data after that date and time will be
corrected.  If more than one data point is included in the compensation file, data between points will
be corrected linearly.

To enter the compensation filename, press TAB while the highlight cursor is on Compensate.  The
highlight cursor will move to the right.  Enter the path and file name.

Example: C:\DO.CMP Enter.

When you enter a compensation filename, the program performs a test load of that compensation
file.  A summary is displayed so you can verify the file structure.  The summary includes how many
lines were accepted, rejected, or blank, the total number of lines, and the earliest and latest date.

If you compensate a constant used in calculating one parameter, you must also compensate the same
constant if you use it to calculate other parameters.  A total of 1000 compensation points are
allowed for any single report or plot.

Select Control Info from the Modify menu.  The Control Info menu will be displayed.

Enter title line
SAMPLE.DAT

First sample was at: 02/05/92 13:58:00
Enter start time: begin
Enter stop time: end
Last sample was at: 02/06/92 11:42:00

Logging interval was: 60 seconds
Enter averaging interval: 0

X-axis time per screen: 1304

Cross-parameter style: AVG
Cross-parameter bins: 100 (maximum 2350)

Parameters per plot: 2
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The Control Info menu allows you to report or plot an entire file, or any portion of a file.  Other
options on the Control Info menu allow you to average several data points together and set up
reports and plots to display data in the format you choose.

Below the prompt, Enter title line, assign a title that will appear on all reports and plots.
SAMPLE.DAT is shown in the example screen above.

Select the four options below to view start and stop times of the file, and specify portions of the file
to report or plot.

First sample was at:
Enter start time:
Enter stop time:
Last sample was at:

The first and last line of this block of information indicates the actual start and stop times of the
current file.  You can identify any segment of time from within a file to report and plot data.  For
example, if the duration of the deployment was five days, but you wish to see a report and plot for
only the third day, simply enter the start and stop dates and times associated with day three.  Even
though all five days of data are retained, reports and plots will show only day three.

The following two options show the sampling interval which was in effect throughout the
deployment and a method by which you can consolidate readings to improve report and plot
appearance.

Logging interval was:
Enter averaging interval:

You may choose to average several data points together for reporting and plotting.  For example, if
the sondes readings were captured every 900 seconds (15 minutes) during the deployment, you
might want the reports and plots to average four of these readings together so that the information
can be reported or plotted on an hourly basis.  To do this, define an averaging interval of 3600
seconds.

Select X-axis time per screen option to specify the time interval on the X-axis.  This line is only
applicable when Date + Time have been defined for the X-axis. You can define the width of a given
plot screen in minutes by changing the number of minutes in this option.

Select Cross-parameter style to choose one of four plot styles.  This option is only applicable if a
parameter other than Date + Time is selected for the X-axis (see Parameters above).

An averaged plot (AVG) assumes a correlation between the X-axis and the Y-axis parameters.  The
averaged plot divides the X-axis into equal-sized memory bins.  Each sample is tallied into the
appropriate memory bin based on its X-axis value.  When finished, the average value for each
Y-axis parameter in each memory bin is displayed.

A sequential plot (SEQ), plots each point successively as it comes from the data file.  A sequential
plot provides more detail on the data than an averaged plot, but can appear rather messy.
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The increase (INC) and decrease (DEC) plots are types of sequential plots.  An increasing plot only
displays points when the X-axis values are increasing.  A decreasing plot only displays points when
the X-axis values are decreasing.  The increasing and decreasing sequential plots are especially
useful if you are profiling and display depth on the X-axis.  Thus the plot shows only the time in
which the sonde is being lowered or raised.
Select Cross-parameter bins to set up the number of bins that will appear on the X-axis.  This
feature only applies to reports and averaged plots (see descriptions above) with a parameter other
than Date + Time on the X-axis.  Changing this value modifies the number of bins into which the
X-axis is divided.  The smaller the number of bins, the wider and more general is the plotted
information.  The maximum number of allowable bins varies with the capability of your computer
system, and is displayed in parentheses.  For example, 100 is selected, and the maximum is 2350 as
shown in the screen above.

Select Parameters per plot option to setup the number of parameters that will be plotted together.
If you choose 1, there will be an individual X and Y-axis displayed for each selected parameter.
Select any number of parameters per plot, (from 1 to 4) which provides your data with the best plot
presentation.

Select Scaling Info from the Modify menu.

Scaling technique: automatic
Copy default to manual
Copy automatic to manual

Default
Scaling

Manual
Scaling

Automatic
Scaling

Parameter Units Minimum Maximum Minimum Maximum Minimum Maximum

------------ ------ ------ ------ ------ ------ ------ ------
Temperature C -5 45 -5 45 4.6 2.1
Conductivity mS/cm 0 100 0 100 0 100
pH 2 14 2 14 2 14
ORP mV -1000 1000 -1000 1000 -1000 1000
DO mg/L 0 20 0 20 6.1 15

There are three scaling options.

Default Scaling offers fixed limits.  These limits correspond to the range of each parameter
as defined by the sensor specifications, so your plot will always fit within these limits.

Manual Scaling allows you to enter custom limits for each parameter.

The computer scans the data file and determines the limits, then displays those limits on the
plot in Automatic scaling.

NOTE:  When entering a scaling technique, you need only type the first letter of the desired
technique and press Enter.  PC6000 will fill in the rest.

Select Copy default to manual or Copy automatic to manual to provide a quick way to copy
from either the default or automatic limits columns to the Manual scaling column.
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Once you copy data into the manual scaling column, it can be modified.  After copying is
complete, you will lose “manual limits” that were defined previously.

! You can not change Default Scaling limits.
! You can change Manual Scaling limits.
! You can not change Automatic Scaling limits, but they are updated each time an automatically

scaled plot is generated.

4.1.2 VIEW

All of the VIEW file options allow you to view file data on the screen.

Filename:  SAMPLE.DAT

MODIFY VIEW SYSTEM

Parameters... Header Print Report
Control Info... Report Print Plot
Scaling Info... Plot Definitions...

Statistics Export

Select Header to display complete information about the sonde, probes, and configuration of the
current file.

Select Report to display a complete list of all readings (as defined by the settings in the Modify
portion of the menu) from the current file to the screen.  As the report is scrolled onto the screen,
you can pause at any time by pressing any key.  Once the entire report has been displayed, use the
Arrow keys, the Page Up and Page Down keys, or the Home and End keys to move to any location
within the report.  If your computer system has limited RAM, early data points within a report may
become unavailable for viewing.  To redisplay unavailable data points, simply redisplay the Report
from the beginning.

Select Plot to display a plot of the current data file to the screen.  The plot can be customized, see
Parameters and Control Info above.  A plot can be abandoned at any time by pressing Esc, or
paused by striking any other key.  If a plot is too large to fit on one screen, it will automatically
move to a new screen.

Select Statistics to view statistics of a data file, or portion of a data file.  As with reports and plots,
the displayed statistics are affected by the choices you make in the Parameters, and the Control info
menus described previously.  To view statistics for a portion of a file enter the start and stop times
in Control Info.  Statistics are only available after a report or plot is run.
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Sensor Type Minimum Maximum Mean Std.Dev.

Temperature (C) 4.69 21.00 5.88 2.877
Conductivity (mS/cm) 0.01 29.94 0.41 1.934
pH 6.32 9.44 7.64 0.200
ORP (mV) 75.7 313.5 156.7 36.45
DO (mg/L) 6.12 14.97 6.70 0.696

Number of samples = 1305

To print a copy of the Statistics screen, press the F2 key.

4.1.3 SYSTEM

SYSTEM menu options allow you to print the report and plot the data, or export the data to another
software program.  The specific setup format of the report or plot can also be frozen for future use.

Filename:  SAMPLE.DAT

MODIFY VIEW SYSTEM

Parameters... Header Print Report
Control Info... Report Print Plot
Scaling Info... Plot Definitions...

Statistics Export

Select the Print Report option to send your report to the printer.  After you select this option, a
prompt appears on the screen asking if your printer is ready.  Press Enter to proceed with the print
operation.  If more than 8 parameters are to be printed, PC6000 will assume you have a
wide-carriage printer.  If your printer is not wide-carriage, set your printer to compress mode before
printing (see your printer manual for instructions). The printer port option, in the setup menu,
specifies the computer port to which the report will be sent.

Select the Print Plot option to send your plot to the printer.  After you select this option, a prompt
appears on the screen asking if your printer is ready.  Press Enter to proceed with the print
operation. The printer port option, in the setup menu, specifies the computer port to which the plot
will be sent.

Select Definitions to create and save different report or plot configurations from the same data file.
Each file contains all options and setup information you defined in the Modify menus, see the
MODIFY options section, described earlier.  After you have selected Definitions from the
SYSTEM menu.
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Active definition: default report/plot

Select an action: Select a definition
Create new definition
Rename active definition
Delete active definition
Clear active definition

Active definition  displays the name of the current active definition.

Highlight Select a definition and press Enter to retrieve an old definition.

Highlight Create new definition and press Enter to create a new report and plot format. You will
need to name the new definition, then specify the new definition by variation of the current format.

Example: if you want to report and plot only dissolved oxygen readings in mg/L
for your study instead of all parameters, first create a new definition at the prompt
by typing “DO”.  Then exit the definition menu by pressing Esc.  Scroll to the
Parameters menu and eliminate all parameters except DO, mg/L.  This data
presentation can then be reported, plotted, or exported, but more importantly, if
you return to this data file at a later time, the “DO” definition can always be
selected to provide this same data format since it has been saved under its own
designation.

Remember: Always name the new definition in the “create new designation” option prior to making
changes that will define the new format.

Select Rename active definition option to change the name of the active definition.

Select Delete active definition option to remove the active definition from the file.

Select Clear active definition option to reset the active definition to default values.  Thus all
customization features that you previously set up are reset to the default values.

Select Export menu option to export a data file to another program.  After selecting the Export
option you will be asked to name the file to be exported.  The default name is the same as the
current data file with the extension .PRN, .CDF, or .SDF, depending on the export format selected,
ASCII, Comma & Quote Delimited or Space Delimited, respectively.   Export formats are selected
in the Advanced Setup menu, see Section 4.2, Setup Menu).  After the file has been exported to
disk, it can be retrieved using any program you choose.  This feature is especially useful when
exporting to a database or a spreadsheet program.  Follow the importing instructions outlined in the
destination program to retrieve the export file you have created.



4.2 SETUP MENU

Highlight Setup from the PC6000 menu bar and press Enter to configure the PC program to your
specifications.

------DISPLAY-FORMATS---- ---------COMPUTER-CONNECTIONS--------
Date format: mdy Comm port: 2
Date separator: / Baud rate: 9600
Time separator: : Printer port: 1
Radix mark: . Printer type: HP LaserJet laser

--------MORE-SETUP------- -----------COMPUTER-DISPLAY----------
Data capture setup... Menu colors: Pacific Ocean (color)
Advanced setup... Plot colors: Danube River (color)

Graphics mode: Automatic selection

Other than the Comm port and Printer port options, the default values should be adequate to
perform virtually every function of the Sondes.

Under the COMPUTER-CONNECTIONS heading, select Comm port to make necessary changes
if the default value is not correct.  This option must be properly set before you can communicate
with the software inside the Sonde.  See Section 4.1.3, System, to verify agreement between the
sonde and PC software.  If you have difficulty communicating with the sonde, change the Com port
and try again.  PC6000 allows only Com port 1 or 2.

Change the baud rate by highlighting Baud rate, then press Enter.  Select from the list of possible
baud rates that are displayed.  The baud rate you select here must match the baud rate set in the
sonde (which defaults to 9600).

Select Printer port to specify where your computer’s printer is connected.  If you have difficulty
printing, specify a different printer port (1, 2, or 3) and try again.

Select Printer type to provide a list of printers that are supported by PC6000.  Select a printer that
best describes your system's printer.  If you have difficulty printing, try a different selection here.
You may need to consult the printer instruction manual to determine what type of printer your
printer emulates.  The printer type option only affects plot output, having no effect on report
printing.
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Under DISPLAY-FORMATS change any default values that are not appropriate by typing in the
correct format.

Date format: mdy
Date separator: /
Time separator: :
Radix mark: .

Users may specify any order of day (d), month (m), and year (y) by selecting Date format.  The
other options are used primarily outside of the US where other characters are sometimes used to
separate numbers in dates, times, or decimals.

Use the options below to specify what type of monitor your computer has, and change the colors of
both menus and plots as they are displayed on the screen.

Menu colors
Plot colors
Graphic Mode

The color selections have no effect on the printed output of reports and plots.  Simply press Enter
to activate either the Menu or Plot color selections, scroll through the choices with the Arrow keys,
and after selecting a color scheme, confirm it by pressing Enter again.  If none of the color schemes
are to your liking, you can setup a User Defined color scheme.  See Section 5, Advanced Setup.

From the list provided, choose a graphics mode which best matches your video adapter and
monitor.  If you have difficulty, consult your video adapter's instruction manual.

Under MORE-SETUP there are two important menu options.  Each has been given a separate
subsection.  Section, Data Capture/ Real-Time Setup, provides the instructions for you to
configure your sonde to provide “real-time” graphical display of in the discrete sample mode.

4.3 DATA CAPTURE / REAL-TIME SETUP

When Real-time mode has been properly set up, you will be able to view the data in real-time as it
is taken in the Discrete sample mode by the sonde.  Each reading is displayed at the bottom of the
real-time screen, and plots are updated with the arrival of each data point.  In addition, the data will
be automatically stored to the disk drive that you select.
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The Data capture setup screen will appear similar to the one shown below.

Parser: 6000 X-axis time per screen: 1
Site name: YSPRINGS Parameters per plot: 2
Instr ID: 96K12345 Beep notification: off
Filename: CLRLAKE2      Auto-configure

Column Parameter & Units Minimum Maximum
------- ----------------- -------- --------

1 Temperature (C) -5 45
2 Specific Cond (mS/cm) 0 235
3 DO (%) 0 200
4 DO (mg/L) 0 20
5 DO Charge 0 110
6 pH 2 14

The Data capture setup process is not difficult, but you must carefully follow the instructions below
to be sure of successful operation.

STEP 1.  Verify parameters in the Report setup (sonde software).  Select Sonde from the PC6000
main menu bar and, if required, type “menu” at the # sign.  Select 1-Run, then 1-Discrete sample,
then 1-Start sampling.  Make certain that the parameters that you want to view in real-time are
displayed correctly.  Adjust these parameters, if necessary, via the Report Setup menu in the Sonde
software.  Check these parameters again by viewing what is displayed on the screen.  Exit the
Sonde menu by pressing F10 and return to the main menu bar of the PC6000 software.

STEP 2.  Choose parameters in Data capture setup (PC6000 software).  From the PC6000 main
menu bar select Setup, then Data capture setup.  Verify that the Parser setting is “6000” for
600XLM, 6600 and 6920 sondes or “600” for 600R, 600XL and 6820 sondes.  If not, type “6000”
in at the prompt and press Enter.  Enter an appropriate site name, then press Enter.
The Site Name identifies the sampling location and is displayed on the File Header and Real-Time
screens and printouts.  Enter an appropriate file name, then press Enter.  The filename is limited to
8 characters.  Next highlight Auto-configure, then press Enter. There will be a 5-10 second delay
while the PC6000 software examines the sonde software to determine the parameters that you have
decided to view in real-time.  When the process is complete, these parameters appear in the list in
the lower portion of the Data capture setup screen.

STEP 3.  Set up display parameters which you wish to view (or hear) in real-time.  Be sure to press
Enter after each entry.  First, set the X-axis time per screen in minutes.  Next, set the Parameters
per plot that can be a value from 1 to 4.  Finally, set the Beep notification to indicate the
acquisition of good data, bad data, or all data (both).  Bad data contains errors in the communication
protocol when arriving from the sonde.  This is rarely observed.  If you prefer, you can eliminate the
beep function completely by selecting “off”.  Simply type in one of the 4 notifications (good, bad,
both, off) indicated above, and press Enter.

STEP 4.  Set the scaling for each of the parameters in the lower right portion of the menu.  There is
no automatic scaling in this mode, so you should select the manual scaling ranges that will result in
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a meaningful display of your data.  These selections will become easier with experience.  Use the
Tab key to move from Minimum to Maximum, and the arrow keys to move vertically within the
scaling limits.  Be sure to press Enter after each scaling entry.

STEP 5.  Start sampling with the sonde.  After entering scaling factors, exit to the PC6000 main
menu bar by pressing Esc twice.  Then access Sonde from the PC6000 main menu and press Enter.
Type “Menu” at the # prompt and press Enter.  Select 1-Run, then 1-Discrete sample, then 1-
Start sampling and begin sampling at the sample interval that is suitable for your study.  While the
discrete sample mode is still operative, exit to the PC6000 main menu bar by pressing F10.  Do not
press Esc or the sampling will be terminated.

STEP 6.  View the data in real-time.  From the PC6000 main menu bar, select Real-Time and press
Enter.  The Discrete Sample data from the sonde will be plotted on the display and will be logged
to disk automatically under your designated file name.

COMMON CAUSES OF ERRORS IN Real-Time MODE

The Parser is not set correctly.  Set the Parser by typing in  “6000” for 600XLM, 6600 and 6920
sondes, and “600” for 60R, 600XL and 6820 sondes.

You have selected more parameters in the Sonde Report setup than can be viewed on the
computer screen.  Remove Time and Date and/or other less important parameters in the Report
setup menu so that all selected parameters are visible in Discrete Sample display.

The name that you entered for your file name already exists on your storage disk, but the file
format for the initial study is different from the current file format.  Change the name of the
data file or delete the existing data file of this name from your disk.

You exited the Discrete sample mode of the sonde software using Esc rather than F10.  Return
to the Sonde menu and select 1-Run.  Restart the Start sampling mode and exit with F10 to the
PC6000 menu bar.  Choose Real-Time and press Enter.
 



SECTION 5 ADVANCED SETUP

These options are provided for the advanced user who has special requirements of PC6000.  It is
important to remember that the default values assigned to these options will be appropriate for most
operations.

Select Setup from the PC6000 main menu bar, highlight Advanced Setup and press Enter.
Advanced Setup menu appears.

-------------GLOBAL-SWITCHES---------
---

------------EXPORT---------
--

Default scaling technique: automatic Export file format: prn
Default parameters per
plot:

2 Export date format: form

Full screen sonde menu: no Export header
format:

-

Multiple formula query: yes CDF delimiter: ,

---------------DATA-FILES------------
---

Default data directory:

--------------USER-DEFINED-----------
---

User-defined menu
colors...
User-defined plot
colors...
User-defined printer control codes...

Select Full-screen sonde menu: yes to specify whether terminal emulation should use the entire
PC screen, or should take place within the usual border drawn by the PC software.

Select Export date format:      FORM to choose from a variety of date formats for the exported
data.

FORM (formatted):
MM/DD/YY and HH:MM:SS.

SEP (separated):
6 numeric values (m,d,y,h,m,s).

COMB (combination):
YYYYMMDD and a string of the form HH:MM:SS.

JUL (Julian):
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A ten-digit integral number of seconds past midnight March 1, 1984.

NUM (numeric):
A fixed point number of the form DDDDDD.TTTTTT where DDDDDD is the number of days past
December 31 1899, and where TTTTTT is the fractional part of the day which has elapsed (.750000
is 6 PM).

REL (relative):
A fixed-point number of the form HHHH.HHHH giving the number of hours elapsed since the first
sample in the file.

NOTE: The export date format only applies to CDF and SDF export files.  The date and time
formats displayed on the PC6000 screen are determined in the SETUP menu.

Select Export header format:    --  to specify what header lines (if any) should be included at the
top of CDF and SDF export files.  The header can contain up to three lines.

(-): No header lines.

P: One header line, containing the name of each Parameter.

U: One header line, containing the name of each Unit.

T: One header line, containing the name of the report Title.

Select Multiple formula query:   N  to change the characteristics of a derived parameter.  This
option should be set to N for no, except for advanced users.

Select User-Defined menu colors to customize the menu colors of PC6000.  Changing the colors
using this option permanently modifies the color scheme of User Defined Colors in the Setup
menu. To use this feature, select a menu item to be changed from the lists provided.  Find the box
that has the same title as the item you selected.  Stop scrolling when the desired color is displayed
and press Esc.. Continue this process until all colors appear to your liking.

Select User-Defined plot colors to modify the plot colors of PC6000.  As detailed in the
User-defined menu colors section above, select plot items to be changed from the list provided and
press Enter.  Watch the sample plot as you repeatedly press Enter.  Press Esc when the item color
you prefer is displayed.  Repeat this process until all plot colors are to your liking.

Select Default Data Directory: to specify the drive and directory to which you want all PC6000
files to be stored.  Type the drive and directory to which you wish all PC6000 data files to be stored
when captured from the sonde.

Example:  Typing C:\PC6000 would save all data files to the C:\ drive and to a
directory called PC6000.

Select User-defined printer control codes: to manually enter special printer commands.  Consult
your printer's instruction manual for the specific commands compatible with your printer.
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Select Export file format:         PRN to setup a format if you wish to export data to another
program.  See Section 4.1, File Menu for more information.  The software determines the correct
format to specify to which you want to export data.  Consult the manual of the destination software
to determine the compatible format.

The three export format choices PC6000 allows are:
Printer format (PRN):
Select this option to export data in exactly the same format as it would be sent to a printer.  All page
headings, column headings, and form feeds are present in the export file.

Comma & Quote (“ “) delimited format (CDF):
Select this option to export data in a format that encases all strings of data in double quotes, and
separates each option on each line with a comma (or other delimiter character).  There will be no
spaces on any line unless they are inside a string.

Example: "12/31/92","23:59:59",123.45,12.3,123

Space delimited format (SDF):
Select this option to export data in a format with fixed-column fields, which can be string or
numeric.  Strings and dates are left justified in their field, numbers are right justified.  Strings are
not encased in quotes.  Lines are fixed width, and columns are apparent when viewing the file.
Field widths are as follows:
•  title is 80 characters
•  parameter names and units are 8 characters each
•  numbers are 8 digits including the radix separator and decimal digits
•  formatted dates are two 8 character strings separated by 1 space
•  separated dates are six 3-digit values
•  combined dates are an 8-digit number and an 8 character string separated by 1 space
•  Julian dates are 10 digits
•  numeric dates are 13 digits
•  relative dates are 9 digits

Example: 12/31/92 23:59:59 123.45 12.3 123

Select Default scaling technique: or Automatic or Default parameters per plot:  2 to modify the
default values for reports and plots.  These options are described in detail in Section 4.1.1, Modify.
The Setup menu determines what the default scaling technique and parameters per plot should be
for each new data file. Change the values here to modify these options for future reports and plots.
To modify these options only for a current file, see Section 4.1, The File Menu.



SECTION 6 TROUBLESHOOTING

This section contains a troubleshooting table that will be helpful to identify the causes of the
most common difficulties that may occur while operating the PC6000 software. The Symptom
column describes the type of difficulty that you might experience. The Possible cause column
describes the conditions that might cause the stated symptom. The Action column provides
simple steps that can be followed to correct for the "possible cause" and cure the "symptom"
being experienced. The column entitled Ref is the number of the reference section and
subsection in the manual where you may find additional information.
 
If you need assistance that this Troubleshooting section can not provide, please contact YSI or
your authorized dealer.   See Section 7 for specific contact information.

SYMPTOMS POSSIBLE CAUSE ACTIONS REF
PC6000 software
operates but no data
are captured to disk.

Data capture not set up Move cursor to data capture
setup and make proper
selections.

3

Will not auto configure. Enter  parser, site name , ID 5
After auto configure, no data
arrives

Return to sonde menu and start
sonde

PC6000 displays data,
no files found.

Data directory path not
recognized

Move cursor to PC6000
Advanced setup and establish a
directory

2

Data files not readable Export file as PRN, CDF, SDF 6
Expected parameters
are not displayed on
reports or plots

Parameters not added to Y-
axis list

Add parameter 3

Sensor disabled Check sensor setup instructions
in the sonde manual

Unable to print
reports or plots

Printer port improperly
configured

Try a screen print out to the
printer (print scrn)

Printer port improperly set Check setup 6
Printer type improperly
selected

Check setup 6

Print cable improperly
connected

Check connections at both ends

Video screen of PC is
not readable

Incorrect menu color option
has been selected

Select appropriate menu
parameter

Incorrect graphic mode Select compatible graphic mode 5
When selecting
“sonde” from PC6000
top line, sonde menu
not shown

Prompt # appears in place of
menu

Type “menu” and press (enter) 4

Communication problem Make certain com port
selection is correct.



SECTION 7 CONTACT INFORMATION

For any questions regarding PC6000 software, or any YSI equipment, please contact YSI Technical
Support at (800) 897-4151 or e-mail at ysi@support.com. For ordering YSI equipment or
accessories, please see your YSI dealer, or the contact information below.

1700/1725 Brannum Lane
Yellow Springs, Ohio 45387 USA
(800) 765-4974  (937) 767-7241
FAX: (937) 767-9320
Website: http://www.ysi.com
E-mail: info@ysi.com

mailto:ysi@support.com
http://www.ysi/com


SECTION 8 SENSOR DRIFT APPLICATION NOTE

SENSOR DRIFT COMPENSATION

The following application note is designed to facilitate the use of the sensor drift software included
in the PC6000 package by providing the user with a specific example.

After laboratory calibration, a user deployed their sonde in a readily accessible stream on 10/14/92
with the instrument set to capture data to memory at 15-minute intervals.  The study was named
SRUN7.  The instrument was left in place for approximately 2 weeks and during this time period,
the user visited the site 3 times, took a water sample in a sealed bottle, and, on returning to the
laboratory, measured the dissolved oxygen and pH with recently calibrated instruments.  The user
also collected a water sample when the instrument was retrieved (10/26/92) and measured dissolved
oxygen and pH in the laboratory.  The following records were kept.

Laboratory Measurements

Date Time DO (mg/L) pH

10/17/92 8:00 5.40 7.62

10/29/92 8:00 7.50 7.63

10/23/92 10:00 7.30 7.58

10/26/92 8:15 6.32 7.60

The user now has everything required to compensate the DO and pH readings for field drift:

" The data file captured by the computer or data collection platform.
 
" The correct DO and pH readings at various times during the study based on grab samples of

water which were analyzed with recently calibrated laboratory instruments.
 
" PC6000 software for retrieval and manipulation of the data from the sonde memory.

COMPENSATION PROCEDURE

1- For this example, make certain that the data file is present in a subdirectory of the hard
drive (C:\PC6000).

2- "Exit" from PC6000 software using the top menu bar. The "C:\PC6000" prompt
should be displayed.
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3- The user must now write compensation files which contain the above data points and
which will be accessed automatically by the PC6000 software.  If the "C:\PC6000" prompt is
displayed, the  files will be located in the same subdirectory as the SRUN7.DAT data file.  A
compensation file for each parameter (DO and pH, in this example) must be written.  Since the
overall filename is SRUN7.DAT, the DO compensation file will be called SRUN7DO.CMP
and the pH compensation file will be called SRUN7PH.CMP.  Note that for accurate record
keeping, the compensation file name should somehow be related to the name of the overall
study.  For example, it will become extremely confusing if all dissolved oxygen compensation
files are named "DO.CMP" as shown in the brief example in the manual.

4-  To compose the DO compensation file, type the following at the "C:\PC6000" prompt:

The screen will display "1 File Copied" if all is correct and the file SRUN7DO.CMP will now
be in the "PC6000" subdirectory of the C drive. Note that the data must be entered in exactly the
above format:

(1) The time must contain a designation for seconds even if the user does not
know this value exactly; an entry of XX:XX:00 is suggested for all time inputs

(2) There must be a space between the date, time, and parameter value entries.

5-  To compose the pH compensation file, type the following at the "C:\PC6000" prompt:

The screen will display "1 File Copied" if all is correct and the file SRUN7PH.CMP will now
be in the "PC6000" subdirectory of the C drive.

6- After writing the DO and pH compensation files to the C:\PC6000 directory, type
"PC6000" at the "C:\PC6000" prompt to re-enter the PC6000 software package.  Just as would
be done for no compensation, prepare the plot and report output format desired by manipulation
of the "Parameters", the "Control Information", and the "Scaling Information".

7- After the format is finalized, re-enter the "Parameters" section of the software.  Place

C:\PC6000 COPY CON SRUN7DO.CMP --
(Return)
10/17/92  8:00:00 5.40 (Return)
10/20/92  8:00:00 7.50 (Return)
10/23/92  10:00:00 7.30 (Return)
10/26/92  8:15:00 6.32 (Return)
Control Z (Return)

C:\PC6000 COPY CON SRUN7PH.CMP --
(Return)
10/17/92  8:00:00 7.62 (Return)
10/20/92  8:00:00 7.63 (Return)
10/23/92  10:00:00 7.58 (Return)
10/26/92  8:15:00 7.60 (Return)
Control Z (Return)
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the cursor on the "DO (mg/L)" entry, press "Return", and then select the "Detail this parameter"
option within the window.

8- Move the cursor to the "Compensate" entry and press "Return".  Move the cursor to
the "DO, mg/L" entry and press "Return" to activate the compensation of this parameter.

9- Press the "Tab" key once to move the cursor to the right portion of the screen and then enter the
location and designation of the DO compensation file in this bar.  In this case, the entry is:
C:\PC6000\SRUN7DO.CMP.  Press "Return" and the screen should appear as follows if the
procedure has been followed:

10-  Carry out the same procedure for pH:
(a) Activation of the compensation, and
(b) Entry of the location and designation of the pH compensation file.

Parameter: DO (mg/L)
Formula: Temp (C)      Cond (mS/cm)       DO (%)
Inputs: Temperature (C) from 6030* probe, channel 0

Conductivity (mS/cm) from 6560 probe, channel 1
DO (%) from 6560 probe, channel 2

Compensate: DO (mg/L) c:\pc6000\srundo.cmp



SECTION 9 ACCESSORIES

STANDARD EQUIPMENT WITH YSI SONDES

" 600R, 600XL, 600XLM, 6820, 6600 or 6920 Sonde with Calibration Cup
" EcoWatch for Windows Software
" Operations Manual
" Guard for Probe Compartment
" 6570 Maintenance Kit
" 6560 Conductivity/Temperature Probe ( not supplied with the 600R)

PROBES FOR THE SONDES

" 6560 Conductivity/Temperature Probe
" 6561 pH Probe
" 6562 Rapid Pulse DO Probe
" 6565 Combination pH/ORP Probe
" 6026 Turbidity Probe, wiped
" 6036 Turbidity Probe, unwiped
" 6882 Chloride Probe
" 6883 Ammonium Probe
" 6884 Nitrate Probe

OPTIONAL ACCESSORIES FOR THE SONDES

" PC6000 Software (Available at no cost)
" 6027 Turbidity Wiper Kit
" 6035 Probe Reconditioning Kit for 6562 Dissolved Oxygen Probe
" 062655 Carrying case
" 6038 12 VDC power supply with 110 VAC input
" 6037 12 VDC Power Supply with 220 VAC input
" 6100 External Power Connector, attaches to 6095B Field Cable
" 6570 Maintenance Kit
" 5775 Membrane Kit
" 6108 Desiccant Cartridge Kit
" 6109 Desiccant Canister Kit
" 065802 Replacement Desiccant

CABLES FOR THE SONDES

" 6093 Field Cable, 100 ft (30 m)
" 6092 Field Cable, 50 ft (15 m)
" 6091 Field Cable, 25 ft (7.5 m)
" 6090 Field Cable, 8 ft (2.4 m)
" 6191 Field Cable, Vented, 25 ft (7.5 m)
" 6192 Field Cable, Vented, 50 ft (15 m)
" 6067B Low Cost Calibration Cable, Dry use only; 10 ft (3m)
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" 6077B CE Calibration Cable, 10 ft. (3m)
" SP6093-L Special field cables available in 25 ft (7.6 m) increments; Maximum 1000 ft (305 m)
" 6098B Field Cable to 610-D/610-DM adapter
" 6096 Field Cable to Flying Lead (wire) adapter, 15 ft (5m)
" 6095B Field Cable to Female DB-9 (PC Serial with Power Connector)
" 6099: 610 to Female DB-9 (PC Serial)
" 6100 External Power Connector, attaches to 6095B Field Cable (6ft)
" 6102: 610 to Portable Power Pack Adapter
" 6103 MS-8 Dust Cover (caps connector when not in use)

CONDUCTIVITY REAGENTS

" 3161 Calibrator Solution, 1,000 uS/cm (quart)
" 3163 Calibrator Solution, 10,000 uS/cm (quart)
" 3165 Calibrator Solution, 100,000 uS/cm (quart)
" 3167 Calibrator Solution, 1,000 uS/cm (box of 8 pints)
" 3168 Calibrator Solution, 10,000 uS/cm (box of 8 pints)
" 3169 Calibrator Solution, 100,000 uS/cm (box of 8 pints)

pH REAGENTS

" 3821 pH 4 Buffer (box of 6 pints)
" 3822 pH 7 Buffer (box of 6 pints)
" 3823 pH 10 Buffer (box of 6 pints)

ORP REAGENTS

" 3682 Zobell Solution (125 ml)

AMMONIUM REAGENTS

" 3841 1 mg/L ammonium-nitrogen standard solution
" 3842 10 mg/L ammonium-nitrogen standard solution
" 3843 100 mg/L ammonium-nitrogen standard solution

NITRATE REAGENTS

" 3885 1 mg/L nitrate-nitrogen standard solution
" 3886 10 mg/L nitrate-nitrogen standard solution
" 3887 100 mg/L nitrate-nitrogen standard solution

TURBIDITY REAGENTS

" 3845 0 NTU standard
" 6073 100 NTU standard suspension
" 3846 200 NTU standard suspension
" 3847 800 NTU standard suspension
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DISPLAYS, LOGGERS, AND ACCESSORIES

" 610-D Handheld Field Display with Accessories
" 610-DM: 610-D with 128K of memory
" 610-DM: 610-D with 512K of memory
" 614 Ultraclamp, C-clamp Mount for 610
" 615 Leather Carrying Case for 610
" 616 Cigarette lighter adapter (powers and charges 610s)
" 617 Replacement Battery Pack for 610
" 6099: 610 to Female DB-9 (PC serial)
" 6097 Blank port plug for 610
" 6104 Replacement Charger Jack for 610
" 6042 Battery Charger for 610
" 6101 Portable Power Pack for 610 or sondes

LOGGER/TELEMETRY

" 1240: SDI-12 Logger for interfacing as many as 10  6-Series devices.  Can also serve as RF
telemetry platform (RF radio, battery, interface cable, junction box not included)

" 1240B1: 7 amp hour, lead acid 12 VDC rechargeable battery
" 1240B2: 20 amp hour, alkaline 6 VDC battery (2 required)
" 1240AC: 110 VAC charger/transformer assembly, charges 1240B1
" 1240SO: 1240 Solar Panel Assembly, includes panel, mount, cable
" 1240SE: 1240 Serial data interface cable, connects 1240 to PC
" 1240JU: 1240/6 series Junction Box, provides input of multiple SDI-12 devices (standard

configuration is for 5 devices)

Note: For RF radio frequency telemetry system applications, contact YSI Customer Support @ 1-
800-363-3269 (USA) or 508-748-0366 or fax 508-748-2543.

SOFTWARE

" PC6000: MS-DOS compatible communication, upload, plotting
" 610SOFT: Software upgrade for Model 610 D/DM
" 6920SOFT: Software upgrade for Model 6920
" EW-DOS EcoWatch for MS-DOS Applications
" EW-WIN EcoWatch for Windows (Use EW-WIN for 6-Series Applications)
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